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1 &9
GR5405 52 Goodix#fE H i) — FK 2 FrBluetooth 5.3/ &K INFE W 4 (Bluetooth LE) R4kl ., Relg
1E - 40°C ~ 105°CI) %5 I FEJu [l N a2 iz 47, 18id AEC-Q100 Grade2ihilF, BN T-Hur it BEE s 4=
BN
3F-64 MHz Arm® Cortex®-MAF 1%, GR54054E /K 1 2.4 GHz HH#5 (RF) WK HL. (RIHFERE 45370
k. 512 KB}y PIFlash. 96 KBRSISRAM, LI EE KA. %0 BA HEKRFERE, HEg KA (TX) X

Ai5+15 dBm, Bluetooth LE 1 Mbpsta N A#EIL (RX) REUE AI5-99 dBm, FEARBEM P (Link Budget) &
15114 dB.

GR5405:0: bt Fr2 NZ T, AIRCE NS %% (Broadcaster) . W%E#E (Observer) . AMHE %
(Peripheral) A4 (Central) , LA A RIS N

1.1 GR5405 SDK

GR5405 ¥ 1t FF &K B4 (Software Development Kit, SDK) JGR5405 Z 51|SoCHE A 4> T f H I K S #F o
1%SDK % Bluetooth LE API. System APIZE. AMEIRSNFER . AR/ FE I HE . TRERBIHED DL AR S H P 3¢
TR

1.2 {RINFETE il A%
RS FETE U S B P

Bluetooth LE Protocol Stack

Generic Attribute Profile (GATT)

Attribute Protocol (ATT)

Logical Link Control and Adaptation Protocol (L2CAP)

Controller

Link Layer (LL)

Physical Layer (PHY)

& 1-1 (R IhFEEE FF i AR 324
{RIHFEE A i il #s (Controller)  FEHLEEHIFEA (HCD K FEHL (Host) ZHfk.
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¥=#28 (Controller)

«  WFLZE (Physical Layer, PHY) : #F1 Mbps. 2 Mbps. 500 kbps 125 kbps/t] H i N BkHGFSK il
s S (RF) #:4E.

s HEMZ (LinkLayer, LL) : Ml B& R HUIRA, SCRFRA AR
(Standby. Advertising. Scanning. InitiatingEConnection) , J M4 SEBR 7R R VI RES
FHEHEEO (HaD

e FEHLIEHIHELD (Host Controller Interface, HC) : #EfitHost5 Controller [AJfFiE E 10 . %4 1
ERS ] DU O, ] DS ARHEREE$E 10, I QUART. Secure Digital (SD) B{USB. HCI
commandsflleventsif i %% I JZ 7EHost 5 Controller 2 [A[f£ 1% .

F4#1 (Host)

o WIREEIMIEHIFIERCPMZE (Logical Link Control and Adaptation Protocol, L2CAP) : N L JZ#ALZ %
SR BoE B S EANRS, H H SR im0 b i 5 8 15

o ZHEMIZE (Security Manager, SM) : & XECXT RIS KRB TTVE, N B E PSRRI N AR e H 4t
it B it ) 22 A AV B A2 e T g

HEAVMIYEE (Generic Access Profile, GAP) : A2 F FlProfilest L 5 W8 Bl (5 28 B[ 2
M, FEHTSLE 8. B, Bk, RS R, SRS, Ll Rk 5 m BT
k.

«  JEMEWMUZ (Attribute Protocol, ATT) : & X T R4S it N2 ity 2 [6] O R 55 B0 A28 BB

s EAEMITEE (Generic Attribute Profile, GATT) : FETATTIMYZ b, & X T —FR5HTGATT
Client 5 GATT Server 2 [B R &5 28 & B @ F 2, it EZMNHA . Profile & Serviceffi .

LRIR:

* ¥ ZBluetooth LEF AR K H AN IAHICERL, 1 Vi 1A Bluetooth SIGH] B 7 M3k https://www.bluetooth.com.

*  GAP. SM. L2CAP X GATTH#I{G & 7EBluetooth Core SpectH?, HAthBluetooth LEN. /= Profiles/Services it
A LLYEGATT Specs UL [fl F 4. Bluetooth LEJ A 1] fg 2> H 21| [ Assigned Numbers. IDs }2 Codes}?)#1|#f Assigned
Numbers T2 Tf] -
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2 GR5405{RIHFE IS F I HF &

GR5405 SDK & & T-GR5405:t% 1 & WA ThFE W B &K T AF &4, fi4EBluetooth LE 5.3 API. System
AP AN BRENAPI,  FEER AT T A EE 4 A8 B FH 7 5] TR RN A FH 150 BH SRS . N I & 3 AT LA T GR5405
SDK 78 TAZREAT PR = i I R FHIEAR
2.1 BEHLEH

GR5405:85 Fr A HHE ], i R AT :

Bluetooth Subsystem
RF Transceiver
CLK
HFXO_32M ————» Gen —»
v
- Bluetooth LE Bluetooth LE
PA — SX PLL Digital Front End Modem MAC Packet Buffer
.—J: LNA — Mixer — BB _— ADC
PMU Subsystem
1/0
DC-DC BOD
AON_LDO POR UART
CORE_LDO 10_LDO Timers
SYS_LDO
AON SLP
AON WDT N AON RTC
- o o ester e
HFRC_192M CPLL_192M
Analog
RNG_0SC HFX0_32M - Cache ‘ Sense ADC Temperature Comparator
sensor
LFRC_32K LFX0_32K
CGU Subsystem MCU Subsystem
I Radio Power Domain I system Power Domain Always-on Domain

2-1 GRS40SHE{HFHEE]
- Arm’ Cortex -M4F: GR5405 SoCA% ¥ RGHLL L HE S (CPU) . Bluetooth LEWHUE: AlApplication ft
3BT IR F3s b
*  SRAM: FRSBENUAFIIEfEES, FROLRE AT IN BT 75 i A7 25 1]
*  ROM: Hiffff##%, [E1L T BootloaderMiBluetooth LE TSR I HAFARAS o
*  Flash: A NESRIFlashfEif 500, T Fm A AR MEERE, SCREAH PR A Eig 7t

(Execute in Place, XIP) .
*  Peripherals: GPIO. DMA. 12C. SPI. UART. PWM. Timer. ADCJATRNGZ:HE{EAMA .
*  RFTransceiver: 2.4 GHZSHHl R 2% .

e Communication Core: Bluetooth 5.3V ARIEHI S I Z, $RALERA MR 5 2.4 GHZSFH A 2 [A]
FEfEE .

*  PMU (Power Management Unit) : HEJFE I, NE RGBSR EIE L. TR IEACE S HA
MHTRGIEITIRE, W ESTADC-DC. SYS_LDO. 10_LDO. CORE_LDO. RF Subsystemi&iZ:%k, st
BIhFEE B E B

FRALITE © 2024 WRINTHC TR A BRA 7 3
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LR

KT O SR FEAAN4H, 155 % (GR5405 Datasheet) .

2.2 3\ 54

GR5405 SDKIF #4844, tnF B Frs .

Software
Application
SDK
Bluetooth LE API System API APP Driver
A A i
HAL Driver
Bluetooth LE Stack Bootloader LL Driver
Hardware I I
\ 4 \ 4
Bluetooth 5.3 Core Arme® Cortex®- M4F Peripheral

2-2 GR54055R 5244
. Bootloader
FAE S R A B 51 SRR, SASTRIIR S B 3R, R0 IR R Sl R
. Bluetooth LE Stack

{RIHFERE A i S BLAZ Oy, HHEERIES (Controller) « ENUEHIEZT (HCD FIEHNL (Host) P4,
(BFELL. HCI. L2CAP. GAP. SM. GATT) , 3Z#FBroadcaster. Observer. PeripheralfliCentralffiff .

. LL Driver
JRZWENE, BN FARREIR SN, AR MR i A B
. HAL Driver

LR RIS )2, I TAPPIREN ZEMILLIKS) 2 2 (B ) — Ml R 2 . R4t —dHbsE L APz, A
77 {5 APPER ) |2 38 ik 18 FHHALZAPIL 1] JiS 2 A B U

(10 {52 AR
HALZ AP [EH NG H T R R Z I R RIS, AEH T 5N R K. Bk, AHEETA
FHEAHHALZIAPIHE L .

JRBUITAT © 2024 PRYINTHIL TR I 03 A7 FR A 7 a4
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Bluetooth LE SDK
AT & T RAL, $24L7H 8 5 FHfFJHAL API . Bluetooth LE API. System APILL A2 APP Driver API.
Bluetooth LE APIfU#5L2CAP. GAP. SMAIGATT API.

System APIFE XS HE Z) R HE 71 R4 (NVDS) . FirmwareFt2 (DFU) « R HIEE HL DL
WA RFLV; .

APP Driver NN HIRZN 2, FETHALIKBWE & A5 (1) 8 FH D RE 3 25 il — R FIAPL, X U8 MU A
HHALIKFN R, T B ER e %4, S BHEIEN T, #HHEITREEFHAPPZAPI,

Application

SOKEIRAL T 8 WIS F R AN R TARE, HAEAN RG] TARERE &9k a1 —dki Sc 4, H P areA
HiEBHE THE S PIBTNAR. T2 T N A, GRToolbox (Android) AL T XF N AT
Ae, A7 (E A PR .

2.3 FhERSARET
GR5405 R 4| SoCHIA TG A Ly, 4 R I AR :

JRBUITAT © 2024 PRYINTHIL TR I 03 A7 FR A 7 5
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F4

(AT

P2

il =
OXFFFF FFFF
Reserved ROM TABLE
0XE010 0000 523264KB ..o ) ) ETN
OXEOOF FFFF Private peripheralbus . TPIU
debugging (external) T
ARM Private
Private peripheral bus DAE
0xEO00 0000 1024 KB h | SCB
OXDFFFFFFF o e (internal) FPU
Reserved T MPU
0x4400 0000 2555904 KB NVIC
Ox43FF FFFF SYSRITCR
FPB
Peripheral BitBanding [I’m
0x42000000 32768 KB
Ox41FFFFFF q d BLE (0x400E_0000-0x400F_FFFF)
eserve
0x40100000 31744 KB TRNG (0x4001_9000-0x4001_97FF)
Ox400FFFFF EFUSE CTRL (0x4001_8400-0x4001_8FFF)
Peripheral EFUSE ARRAY (0x4001_8000-0x4001_83FF)
DMA (0x4001_4000-0x4001_7FFF)
0x4000 0000 1024 KB GPIO1 (0x4001_1000-0x4001_1FFF)
OX3FFF FFFF Reserved GPIOO (0x4001_0000-0x4001_OFFF)
%’;222222%%(;%2 488960 KB PAD_CTRL (0x4000_E900-0x4000_E9FF)
DVS (0x4000_E800-0x4000_E8FF)
RAM BitBanding CLK_CAL_1 (0x4000_ES00-0x4000_ESFF)
0x2200 0000 I CLK_CAL_O (0x4000_E400-0x4000_E4FF)
Ox21FF FFFF MCU_AUX(SNS-ADC eg.) (0x4000_E000-0x4000_E3FF)
Reserved
0x20018000 32672 KB CACHE-XQSPI (0x4000_D000-0x4000_DFFF)
0x20017FFF HTABLE_AMCM (0x4000_CDO00-0x4000_CDFF)
RAM PWM1 (0x4000_CCO0-0x4000_CCFF)
PWMO (0x4000_CB0O-0x4000_CBFF)
0x2000 0000 96 KB UART1 (0x4000_C600-0x4000_C6FF)
Ox1FFF FFFF Resered UARTO (0X4000_C500-0x4000_C5FF)
0x0320 0000 473088 kB 12¢c1 (0x4000_C400-0x4000_C4FF)
Ox031F FFFF 12C0 (0x4000_C300-0x4000_C3FF)
ExFlash Alias SPI_S (0x4000_C100-0x4000_C1FF)
SPI_M (0x4000_C000-0x4000_COFF)
16384 kB
03%32#?:22 AON_GPIO (0x4000_AAOO-0x4000_AAFF)
Reserved AON RF (0X4000_A900-0x4000_AFF)
0x01200000 JesRk
OxO11FFFFF AON PMU (0x4000_A800-0x4000_A8FF)
E— AON WD TIMER (0x4000_A700-0x4000_A7FF)
AON CLDR (0x4000_A600-0x4000_A6FF)
0x00200000 16384 KB AON SLP TIMER (0x4000_A500-0x4000_ASFF)
OX001FFFFF R AON_PWR (0x4000_A400-0x4000_A4FF)
0x00118000 928 KB AON CTRL (0x4000_A000-0x4000_A3FF)
0x00117FFF WATCHDOG (0x4000_8000-0x4000_8FFF)
RAM Alias DUAL_TIMER (0x4000_2000-0x4000_2FFF)
TIMERL (0x4000_1000-0x4000_1FFF)
0x0010 0000 96 KB
OXO00F FEFF TIMERO (0x4000_0000-0x4000_OFFF)
Reserved
0x0003 8000 800 KB
0x0003 7FFF
ROM
0x0000 0000 224 KB

2-3 GR5405 77 fif 23 A&t

*  RAMAEfiE: 3Lo6 KB, bl A0x0010 0000 ~ 0x0011_7FFFEX0x2000_0000 ~ 0x2001_7FFF.

°  0x2000_0000 ~ 0x2001_7FFF: SDKHRW. ZI. HEAP. STACKZFAF &7 T %Xk, SRAMAK 16
KBAZfifi [X 35, 7EMCHE Bluetooth LE T.FERY, T H{EBaseband[’JEM (Exchange Memory) . EMSE
B A5 B X 32k HH custom_config.h 3 B f¥)Bluetooth LEF SOV S &E ke, HAREHKEMX 80K 5 H

i SRAM X 35 F il 2 g bk 4% 6] . 5 4h, 0x2000_0000 ~ 0x2001_3FFF X8 S #5 7 Be i/,
Sob 87 A7 B i hik 022000000 ~ 0x2227 FFFF, A AT H0HE R 11 1E .

[IRURY

°  0x0010_0000 ~ 0x0011_7FFF: H T Cortex -MAFSAZR LR 4, % X 117 1) 8RB T oA X
. P, SDKF'RAM_CODER] $iATACRS AL T-i% X 5

JRBUITAT © 2024 PRYINTHIL TR I 03 A7 FR A 7
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*  Flashf#fi#i: GR5405:%: F 4 #iFlash 4512 KB, bk A0x0020_0000 ~ 0x0027_FFFF.

2.4 Flash 77 i AR5

GR5405:81 35 T —> K FHXQSPLE 2682 11 (1 Al £ [ A i Flash /(i 28 « i%Flash?) 3 F 45 T4 KB K /MiFlash
FIX (Sector) s @i I RIEAFIRIN A5, R4 NASE FH S A7 X 35k

SNGR5405 8L Y N FH 37 5 I Flash A& AT/, W N R,

End of Flash
Non-volatile Data Storage (NVDS)

NVDS_START_ADDR

Unused Space

User App

0x0020_2000

System Configuration Area (SCA)
0x0020_0000

2-4 FlashTZ &% /&
*  System Configuration Area (SCA) : RAFLEX, FEHTHHALABISHEFHEREL.
*  User App: Application Firmwaref7#fii X35, =% H T 776 S & 4 -

*  Unused Space: 7SN X3K, FFRETLLEATMAHZXIE. a1, {EDFUAZIEFEH, f#HUnused
Spacellfi i 77 fifi 1 ] Application Firmware

(0358 RR:

o JFRE T LURYE S i Flash 726 A =, A PR B NVDSHIAR 4f Hhk 5 B 5 F (K Flash Sector®l, FLARLE J7
1£2%4.3.2.1 it & custom_config.h.

*  NVDSHEUf T S5 Flash Sector S af bk Xt 5%
o JTREVRIESEGRTER, BATERItteFSEE TR 41 Se I EE 5 RV BUR A4S .

2.4.1 SCA
ZREGHEEX (SCA) (5 HFlashil P Sector (L8 KB, 0x0020_0000 ~ 0x0020_2000) , H:FEfF4E RS0
ISR bR & DA HoAh RGBS 2

TEFE N, TS EiGProgrammer T H £ #E Application Firmware d1 [KJBUILD_IN_APP_INFO%5 #4444
% Image Info, FF¥3H 5 N H FE4FE— I 525 £ Flash (Image Infof fFAESCAT) . RSt A5, Bootloaderfl
PasCAH 1) A 205 BTG, R30I 5 PRk & Firmware N [ HihE .

BUILD_IN_APP_INFOZE M4 ) 5 SCAITECL & 4n R

JRBUITAT © 2024 PRYINTHIL TR I 03 A7 FR A 7 7
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[ RIR:
LEMRNI T SDK _Folder\platform\soc\common\gr platform.c, FHISDK_Folder’yGR5405 SDKf
MRH .

const APP INFO t BUILD IN APP INFO _attribute_( (at (APP_INFO ADDR))) = {
.app_pattern = APP INFO PATTERN VALUE,
.app_info version = APP_INFO VERSION,
.chip ver = CHIP VER,
.load addr = APP_CODE LOAD ADDR,
.run_addr = APP_CODE_RUN ADDR,
.app_info sum = CHECK SUM,
.check img = BOOT CHECK IMAGE,
.boot delay = BOOT LONG TIME,
.sec_cfg = SECURITY CFG VAL,

#ifdef APP INFO COMMENTS
.comments = APP INFO COMMENTS,

#endif

.reservedl = {APP INFO RESERVED}

}i

. app_pattern: [#] i {E0x47525858.

*  app_info_version: [f{415 S A, L APP_INFO_VERSIONXY Y.

«  chip_ver: [E£FXSNIE A RCA, 5 custom_config.h™H FRICHIP_VERXS M,

*  load_addr: [EFA7fiEHNE, Scustom config.hH ffJAPP_CODE_LOAD_ADDRXY ¥ .
*  run_addr: [EfizfTHihl, Scustom config.hH [\JAPP_CODE_RUN_ADDRX} W .
*  app_info_sum: [E{FEBRREA, HEMLH 3R CHECK_SUM.

*  check_img: RGAENEE S, Hcustom_config.h 1 [FJBOOT_CHECK_IMAGEXT N . 41tk 24 B
N “1” i, JB 3 Bootloader< Xt B 3E AT RS UG

*  boot_delay: JEFNEEZ%, Scustom_config.h"¥JBOOT_LONG_TIMERI N . 4tk S ¥ fic &
N1 B, RGA S SIBRE IR ZERT .

*  sec_cfg: WAEMESH, REE.
«  comments: [E{HHRGR, mAKENN2TH.

SCARIfEA AT J7l, Wi T B B

JRBUITAT © 2024 PRYINTHIL TR I 03 A7 FR A 7 8
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2
36328 Reserved
Comments(12B)
0x0020_2000 Boot Config(4B)
Boot Info F Boot Info(24B)
Bachp . e q SPI Access Mode(4B)
; Version(2B)
(0x1000) Run Addr(4B)
0x0020_1000 / Pattern(28)
Img_Info_10 i Load Addr(4B)
Boot_|Info (‘403)- :
(0x1000) CheckSum(4B)
0x0020_0000 4008 Reserved(8B) APP Size(4B)
Img_Info_1 Boot Config(4B)
(40B)
SPI Access Mode(4B)
Reserved =< Run Addr(4B)
() Load Addr(4B)
Boot Info ] CheckSum(4B)
“a (328) APP Size(4B)

Boot_Info sector

2-5 System Configuration Area®i 5

*  Boot_Info5Boot_Info Backupf7fif #H 715 &£, Boot_Info Backup ~Boot_InfollJ &1 -

*  Boot_Info (32B) XIHHfEffiFirmware/53I{E S . RGJA3NN, Bootloader R JH 2115 B THL
I8, AU IE L Bk 2 Firmware N 3 hE

[}

Boot Config: R4t/HaILEAE .

SPI Access Mode: SPIVji A ALEEE . R EiLE, P LEEML.
Run Addr: Firmwareizf7#ili:, S5BUILD_IN_APP_INFOH ffjrun_addri i o
Load Addr: FirmwarefZ#fiitilit, S5BUILD_IN_APP_INFOH [{Jload_addri} v .
CheckSum: FirmwarefZ36 M1, A fFirmware)s, B FE&EXRENTHH.
APP Size: Firmwareft]Sizef5 5., “ERiFirmware)a, H FEEIEBEIE,

*  Img_InfoX 3 AT /i 2 2 10 MFirmware(s .. 241# FH GProgrammer T~ #Firmware {4 FH DFU T
ZFirmwarel, Firmwarefg & &8 77 2 Img_Info X 1,

o

Comments: Firmwareffiid {55, AKENI2NTFRF. HFlFirmware)m, FEGE LA
HFirmware 3CF 4 /E Commentsfs B

Boot Info (24B) : Firmware/533){E 5, 5Boot_ Info (32B) [H{k24 BytesE#E+HE .
Version: FirmwarefliA{= ., Scustom_config.h-FVERSIONX} B o

Pattern: [fi] 7€ {H0x4744.

JEAUITR © 2024 FINTHETEME A A R A 7
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2.4.2 NVDS

5 K MHIETE4% (Non-volatile Data Storage, NVDS) & — /N & BB B 126 248, HoF FiFlashfif
R )= (Flash HAL) $RAEIFlashiz 542 1, EERFM T Flashd, AIHfR RGH B EHIRE A S Rk,

NVDS A Zuid T A7l N A, B HIRE P IBCE S 8. RS . RS E B LA S 855 (RIIFE
5 (Bluetooth LE) WAt 2 FINVDSTE it B % S0 2 S S 40

NVDS & 4t B A LA e

BB (tag) AL AME—tag IDHTHRIR. HRER AT DAAR P tag 1D Ade Py 7 kAT 130 ORI 5
BUERAE, T TC G SO B A i O B

BEXTFlash /£ i v i RFPEREAT TARAL, SCRPEERLSS . B Bl O 5 244

A X IR NN g HLHE TG B . Flash X3 DL X (Sector) AHLAL, —NSectorfIK /N4 KB
o NVDSTEfiE X 35 o] i B N4 T NSector,  HEC B KIS 4G Mk 753424 KBX 5% .

GR5405 SDKER A {4 FH Flash i J5 S Sector/E AINVDSTE i X 15K, it 44 Hihik A Flash 4 5 Hi bk 6k 22 NVDS X
KN TR AT Ecustom_config.h it & %:NVDS_START_ADDRFINVDS_NUM_SECTORK 7 7ENVDSHE
G FISector®. 75 VEANVDS_NUM_SECTORANE, & NVDSEL I A X 35k, BEASNVDSHT i F i Sector £
79 “NVDS_NUM_SECTOR+1”

L35 8R:
KTNVDSHITEANNAAME U, 1E2% (GR54xx NVDSH 7 FMt)
2.5 RAM7EfiRR 5F

GR5405 RAME A HIE A0x2000_0000, H6 NN AFH: (RAM Block) ZHE% (6*%16 KB) o #EPRAMMNAEELE
] EH AT T T B P LR

96 KB RAMAZfifi Aii Jo i T B s o

0x2001_7FFF

RAM_16K_5
,,,,,,,, 0x2001_4000

RAM_16K_4
,,,,,,,, 0x2001_0000

RAM_16K_3
,,,,,,,, 0x2000_C000

RAM_16K_2
,,,,,,,, 0x2000_8000

RAM_16K_1
,,,,,,,, 0x2000_4000

RAM_16K_0
,,,,,,,, 0x2000_0000

2-6 96 KB RAMPE i B

TR iz T 7 NExecute in Place (XIP) =, Eﬂﬁii?ﬂ‘ﬁﬁ P N R AT A b Flash == (8], H
B T AN EAAEE . REEM BB E )G, BidCache Controller BL1% M Flash %= [ HUFRIZ 1T .

JRAUTE © 2024 RYITTIC RS B A PR A | 10




G@D]X GRS40SICHFEWE T M- &

2.5.1 #HBIRAMTA [
T B 96 % Bluetooth LE T TS 3 17 1y S R RAMAT 5o Tk 2 1T DURRSE = S 3R, A LRAMAT J »

0x2001_8000

EM Max_Size= 16KB
Stack SYSTEM_STACK_SIZE
HEAP SYSTEM_HEAP_SIZE

Unused RAM Space

FPB_TABLE

RW
Zl

RAM_CODE

0x2000_2000

ROM reserved RAM
including .bss and .data Size=8 KB

(retention) 0x2000_0000

RAM_CODE
,,,,,,,, 0x0010_2000

2-7 XIPAEXAYRAM (& Bluetooth LETI2) #/E

RAM CODE 7B A7t T fERAMH HAT ARSI S AT RICR, 0K H e A R #E ik i 0x00
100000 Aliasing Memory[X 1, .

EM{itBluetooth LE COREfEH], FF5MCUFTIEH HISRAM&GE —& 2, {7 T-SRAMI) fie e i il 7% []
Ak HSize U T-custom_config. hH L & HI W A\ 55 8a . & LA Bluetooth LEMNVSS, T
¥ custom_config.h™ 7EM_BUFF_ENABLE[{){E 1% & N0,

Stack FEX TP A TAESS AR . ZE/A & Bluetooth LEMV S5 4N TREH, iStack € X AERAM i =
hkAb; 7% Bluetooth LEMK 55 1) T2 H, KiStacki® XAEEMZ o Stack K /)N Hi 7% SYSTEM_STACK_SIZE &
X, A T AR TR I bR HCUR FH R P55 0 R FH A v FE T L e e L/

2.5.2 RAMEE ;R ETE

£F—RAM Block 7] LAALF =Fh A [A] B YEUIRZS:  Full Power. Retention Power B Power Off.

Full Power: R G4t T ActivellRZASRT, MCUR] PL#E{TRAM Blockits .

Retention Power: Z i A\Sleeptizli, RAM Block F fE I EIE A2k, it R4 M Sleep IR
B F|ActiveRESHEH .

Power off: RG KL, RAM Blocke iy, HAMBEMEIE M SE L. Fik, TR E FHRATRAAEL
R

GR5405 [ YA FEHIT (PMU) 1E RS E s BRIATT )8 S RAM LR . GR5405 SDKH L HRAL T 5¢ &
FIRAM HE R HAPI, JF R 7] LUARBE N FH 75K, A H5AC B RAM Block FEJFUIR 75

JRBUIT AT © 2024 PRYINTHIC TR I 0 A7 R A 7 11



G@D]X GRS40SICHFEWE T M- &

A ashi, BRIAE H BSRAMITFEE FEAE . MR EApplication IRAMAE F 15, H 5h3E17RAM Block H
PORSEH, BARECE RN T

s HFRZActivelRE N, BAAH FHHIRAM BlockiX B N “Power off” JRZAS, {HHHIRAM Blocki% B N “Full

Power” JIRZ,

o M RGH ASleep R, K AR AL FIRAM BlockfR¥F N “Power off” JIRZS, 1 I FJRAM BlockiX &
N “Retention Power” IRZ .

FESCBRN I, I RAMBC BN T -

*  fEBluetooth LEN "', RAM_16K_OFJ R 8 KBTI 45 BootloaderflIBluetooth LEMX AR A# ], Application
A . 1E RGiActivelRAE T, RAM_16K_ORMALT “Full Power” JIRZS: 7E R GiSleepdlli], RAM_16
K_OMNAbF “Retention Power” JRZ%. JFBluetooth LEZEMCU N FH 1] BL{f Fi%RAM Block .

*  RAM_16K_1 5 H:AtRAM Block[¥] & 7] H1Applicationi# 47 Hi &Il € X . GR5405 RAM ELAR HE AT 258K
HISRAM () B2 J5R] FH 28k AT & BIAG R, T8t T AR 4 S o B FH 75 oK BB A Al . IX £5RAM Block ) H,
PR T A4 5, ] LLH Application H 4745l .

L1352 RR:
c  {YU4RAM Block#bT “Full Power” JARZEK, MCUA BEXT H #4715 19] .

«  HEZRAMAEEHAPIFTEAM UL, 2% SDK Folder\components\sdk\platform sdk.hs

2.6 SDKE R4
GR5405 SDKIFI 3L/ H 3k 4549, Wi N FioR:

FAUITE © 2024 RYINTIC TR A% (0 A BR A 7] 12
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GRS40SICHFEWE T M- &

iR

build\config

build\gcc

build\keil

build\iar
components\drivers_ext
components\libraries

components\profiles

3 GR5405 SDK

3 build

config
gee
iar
keil

3 components

drivers_ext
libraries
profiles
sdk

3 documentation
GR5405_API_Reference

3 drivers

[—

external

freertos

™7 mbedtls
™ segger_rtt

3 hal_drv

include

[
source

3 platform

arch
boards
include

[
soc

-
common
-
include
-
linker
-
src

1 projects

™ ble

peripheral

2-8 GR5405 SDKB #
GR5405 SDKH' % UK IV ELNTIA, STk

< 2-1 GR5405 SDK3ZL {32

ik

THREHS, HT A8 custom_config MERCAF . 230 F A TRE LHESH.
IBATGCCHF R IREE T it ZLAE I 1) TR
IBAT KeilFF R IREE T 5 5 1 T H
IBATIARTT A 5 24 P A T R
TR 38 =5 To a4 1 Ik )

GR5405 SDK#E f}tflibraries

GATT Services/Service ClientsSZH 7 (135 3L

LT © 2024 IR TR A A IR 22 7]
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GRS40SICHFEWE T M- &

R
components\sdk
documentation
drivers\inc
drivers\src
external\freertos
external\mbedtls
external\segger_rtt
hal_drv\include
hal_drv\source
platform\arch
platform\boards

platform\include
platform\soc\common

platform\soc\linker

platform\soc\include
platform\soc\src

projects\ble

projects\peripheral

27BCET A

i

APIL ST

GR5405 API Reference

5T Application T & % {8 FHl IR B API L SCA
5 F ApplicationFF & #48 F I SR S APIIEAR D
B=J7FE¥, FreeRTOSUEHY

DR, MbedtlsiE RS

$=J7FE)¥, SEGGER RTTIRILHD
HALIRBAPISL LA

HALBKZh APIJE LA

CMSIS[#Toolchain S

7 il Starter Kt/ AR AR ZATAGACIE S, T2 ZESLBURAR St A0 1 (BT 4R AL o

ISP B AR A LS S
17/l Goodix4: & Bluetooth LE SoCHE 2% /A FLR L4,
Ungr_interrupt.c. gr_platform.cfligr_system.c

RS S B4 5 SRR S

A TISOCH A7 I BIC B 55 5 i = KB AR 5 (1 A 36 30

Fiiflgr_soc.c, EESZINSoCE: Fr A R A — W aR AL I AL SEIL, WIFlash. NVDSHIUH1L

s ARARAL BRI PMUAS %
Bluetooth LE Application T-f£7~f7, #4ible_app_template

O R AMEE TR

R R LR L R 17 GR5405 3% F /&« Iiiak:

AR

GProgrammer

GRUart

GRDirect Test Mode Tool

GRPLT

®22FFR/AATR
ik
B b TH, 3RMEMH N3 FlashiLS . eFuseb5Z5ThAE,
FrWindows/LinuxF- &
TR, CFFWindows T .
DTMIINA TR, Wlidid KIEHCHHr 2614 (DUT) #4701
W, S FFWindows T & .
BUECE TR, RAELEMRRMR (P [EH, fR4ttE
BfE N FlashBdlibesg . SARAELL K& Z IR IIRE, (XK

FrWindows & .

HEFIRA

V2.0.1 5 PL E

V2.1 DLk

V1.55 K%L E

V1.5.0.0.8 5 VL F

LT © 2024 IR TR A A IR 22 7]
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http://www.goodix.com/zh/software_tool/gprogrammer_ble
http://www.goodix.com/zh/download?objectId=64&objectType=software
http://www.goodix.com/zh/download?objectId=107&objectType=software
http://www.goodix.com/zh/software_tool/grplt

GADIX GRS40S{IRINAER T F -1 &5

AR iR HEFER A
(RIREIE A Thae R FHLAPP, mIHH . NEIEESH. ks
GRToolbox V2.20 K DL I

HEProfile%s, 2 ftAndroid/iOSfA .

WAUTE © 2024 RYITTE TR B H RA R 15


http://www.goodix.com/zh/software_tool/grtoolbox

G@Dix Az fE (Bootloader)

3 B2 (Bootloader)

GR5405ff FIXIP (Execute in Place) #:0izf7tid. R4 LG, B35 S R (Bootloader) MRS &
X (SCA) ARG BB ERE R, FrEdsbdt4r N E 4 se BRI . PIiatkCache FIXIPIEHII 28 5, FRBkFE 2
ARG IZ 1T 2 [ PAT E A

GR5405 SDKH f]Application 3 ZhiR AL T Fros:

Boot Start

v

Reset_Handler

v

Init Flash

v

Read boot information
&
Check Integrity of
Application Image

v

Is Application Yes
image integral?

No
Init instruction cache
Start DFU service Jump_to_app(start_addr)

[&] 3-1 GR5405 SDKH B Application/F Bk 2

1. W& LS, CPUKBkf: 220x0000_00004k, M iZthhkAbEL H C-STACKER T B £ HIR(E L MSP, SR
J5i PCFE17]0x0000_0044L, #44T7ROMH [JReset_Handler, i ABootloader.

2. Bootloadert\fTFlash#I 41k -
3. Bootloader MFlashH [FISCAEEEUS {5 B, FFH AT Application Firmware [ 5 B 4G £ .

4. FFFirmware e BEMERT AR, DUJHE N J-Link DFURR . & 3 AT i) -Link B & GProgrammer T HL 5
HiFlash ff] Application Firmware.

5. FFirmwares2 B MEAG EiE i, Bootloader5E XIPHL & Jim ¥ Bk F% 2 Flash 77 [ Application Firmwaref(]iz
Tk, FFEEHATARRS

JEAUITA © 2024 FIINTHEBEMBAR A IR A 7 16



GA@DiX {4 FISOKIF 2t
4 {55 FHSDKFF %& izt

Az LUKeil B, 1] T GR5405 SDK5E fiBluetooth LE ApplicationfFJ B . Zwik. T LR .

4.1 & % Keil

Keil MDK-ARM IDE (Keil) -ARM 2 F B L[ T-Cortex: AIARMIR & 1AL R FF R 148 (IDE) . FFRZ ]
ME J7 W https://www.keil.com/demo/eval/arm.htm T % Keil 22 250, F 3847 %23 . GR5405 SDKAA iz 4T £E Keil
V5.20 & PL_F I RRCAS

(1 35 BR:
%FKeil MDK-ARM IDEFI# F, 7] & HARMIEHERITELL FH 7 FMF:  https://www.keil.com/support/

man_arm.htm.

Kl 4-1KKeil )3 2l J5 1) 3 510

ﬁ - =] X
Fle £t View Poject Flh Debug Perphenss Toos SVCS Window Help

NECL@ % bB|sc|esprnn 1| 8 scovonesve R #[ @0 0 O @@}

LY IE] EREECEY )

Project a2

Eeroy.. [@Books] O Func.|OyTem.. |
ita

B 4-1 KeilFR A E
Keil FR)#5 I D g 120 045 -

= 4-1 KeilE I IThEEIREH

tos3i] Theefik

= Options for Target

)] Start/Stop debug session
£ Download

] Build

WL © 2024 VYT TURHEE by B A ) —


https://www.keil.com/demo/eval/arm.htm
https://www.keil.com/support/man_arm.htm
https://www.keil.com/support/man_arm.htm

GA@DiX

{4 FISDKIT % 137k
4.2 Z 4 SDK

GR5405 SDKEL N.zip 30, BEEARIERI AT A
[ 354 RR:

SDK_Folder yGR5405 SDK U HE H % .

Keil_Folder NKeil 4R H 5% .

4.3 l|#Bluetooth LE Application

KA HFE T Kei T R IEBE, FIHIGR5405 SDKHLIHE B % FH 7 [ 5 X IfIBluetooth LES ]
4.3.1 /% ble_app_example

#:TFGR5405 SDKIE LM TS, B —NFr L.

HEASDK Folder\projects\ble\ble peripheral\, # llble_app_template H3%, FH#H
1}

HAr4 N “ble_app_example” . ¥ble app example\Keil 5H'H].uvoptxHl.uvprojxf] £ 314 E0K
N “ble_app_example”

» ble_app_example » Keil 5

Mame

| | ble_app_example.uvoptx
E ble_app_sxample.uvprojx
PP P proj

[&] 4-2 ble_app_example3Z {3k
Xifible_app_example.uvprojx, fEKeillF¥7FF TFE. fiidi &, #TFF “Options for Target 'GRxx_Soc'” %

&
I, %8 “Output” #rZET, £ “Name of Executable” £2rh#i N\ “ble_app_example” , #42mif) H b5 04444
BN “ble_app_example” .

JRBUIT AT © 2024 PRYINTHIC TR I 0 A7 R A 7
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G@DiX 1 FASDKITF 5 st
U Options for Target 'GRxx_Soc’
Device ! Target Output ]Listing] User ] C/C++ ] hsm ] Linker ] Tebug ] Utilities1
Select Folder for Objects... ] Name of Executable: ;ble_app_example
: % Create Executable: \Objects“ble_app_example
¥ Debug Information I” Create Batch File
V¥ Create HEX File
¥ Browse Information
" Create Library: .\Objects'ble_app_example lib
0K | Cancel Defanlts ‘ Help
4-3 & Name of Executable
fEKeil Project Explorerd, H] &7 Fllble_app_example £  FJFT A groups.
2% Project: ble_app_template
=57 GRux_Soc
[0 gr_startup
[J gr_arch
Ed gr_soc
d gr_board
[ 3 gr_stack_lib
[J gr_app_drivers
L gr_libraries
3 hal_drivers
[J gr_profiles
[ external
L user_platform
[ d user_app
4-4 ble_app_example groups
ble_app_example T.F£ T [Fgroups = £ 7 N2 SDK groupsFilUser groups.
. SDK group
#-SDK group I FEAHiA S WL T -
3% 4-2 SDK groups
SDK group & R IR
gr_startup ARG a3
gr_arch System Core. PMUFIMI4A 0L B SCA4FI 2 40 50 W7 00 4 101 SE
SR © 2024 VRIITHIC TR B4 A7 B A 7 19



G@DIX {4 FISDKIT % 137k

SDK group & 17 ETPED
5SoCHIR AL FESCAT, EERIEHE AmainBi B |, XfClock. PMU. Vector* S 74146 1L S
. 3]
gr_board WG AIR A, F S HLog. Key LedZEAIsc At
gr_stack_lib SDK lib S fF
gr_app_drivers 5T ApplicationTF R (3 F AR BIAPIIE ST o TR E AT ARSR SEBR T oK, AT H Fr i App X3 .
gr_libraries SDKFR A 1 75 F B AR Bl . SNBSS R TR ST A
hal_drivers HALSRBIAPRE SO o TF A3 AT ARYE SEBR TR K, 8 NI H BT HAL BX3) .
gr_profiles GATT Services/Service ClientsJi3CfF. JF R FH TTIRESLPRTE K, W00 E BT % GATTIR ST
eternal H = REF RSO, 5 lIFreeRTOS . SEGGER RTT. JF R # AIARME SLhrmaaR, WINIH A 5 =
TR

. User groups
% -User group M FELIHEIA S IL T 3K

%= 4-3 User groups

User group& iR ik
user_platform A T YR TG R R T I aa Ak, R R T AR SR H R, SEBA R R
FEERBND ., FFAE RN EAIE O, I EBluetooth LEVMMARIZ AT I Z BRI SL B GATT
user_app
Service/Service Client ] 2514 Ab ¥ pR 5.
432FETTE
TR E TR e, BCE AN TR IR, GFENVDS. RIS TR, Frff a8 5 DL A HoAth i B T
faray
=Fo

4.3.2.1 fit & custom_config.h

custom_config.h Tt B Application TFEZ 4L, Tk & WL #E B B8 8O0 85038 18 F Wizard 5t 17247 i
H.

LRIR:

%-Applicationz~ | TFE ] custom_config.hfii +H TR H X FHSrc\config.

- Bewis

GR5405 SDK#R | —~Application TIEHAC B ML (SDK_Folder\build\config\custom co
nfig.h) , JFRHE AT HEESOZER S, BLE Application LIES4L.

FAUITE © 2024 RYINTIC TR A% (0 A BR A 7] 20
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{4 FISDKIT % 137k

=

SOC_GR5405

CHIP_TYPE

SK_BOARD_TYPE

CFG_APP_DRIVER_SUPPORT

ENABLE_BACKTRACE_FEA

APP_LOG_ENABLE

APP_LOG_STORE_ENABLE

APP_LOG_PORT

PLATFORM_SDK_INIT_ENABLE

PMU_CALIBRATION_ENABLE

3R 4-4 custom_config.heF HYE
R
JESUS T RRAS
SRS
0: GR5405

WERR:

ARG, AR SEBRE F RLS F A S BB AL

TR

1: GR5405 SK

Fe AL FH AN APPIRE))

0: AMEH

1: fiH

il /48 AR IR D e

0: &Rkl Th ik

1: ERER R ThAE

APP LOGHEHLIT 56

0: 2% Application Logfith
1: {fifitApplication Loghkifi
APP LOG STOREMHUIF 3.
0: ZXFAPP LOG STOREFER
1: f#HEAPP LOG STOREASIH
B APP LOGH H 5 K

0: UART

1: J-Link RTT

2: ARMITM

18 6 /%% I Platform W 4644, o
0: f#ifEPlatform¥Iaa1L

1: ZEfPlatformBIaa1L
i BE /25 FHPMURSHE T fit

fEREIZIIRESS, RGUM AR E S Bk, JFEEN . U

fit.
0: fHBEPMUKIHE
1: ZEHPMUKHE

1A :

FER /MRS, L AUE REPMURHELI fE -

LT © 2024 IR TR A A IR 22 7]
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15 FHISDKIT % 14

i

=

NVDS_START_ADDR

NVDS_NUM_SECTOR

SYSTEM_STACK_SIZE

SYSTEM_HEAP_SIZE

CHIP_VER

APP_CODE_LOAD_ADDR *

APP_CODE_RUN_ADDR *

SYSTEM_CLOCK *

RF_TX_PA_SELECT

SYSTEM_POWER_MODE

CFG_LF_ACCURACY_PPM

CFG_LPCLK_INTERNAL_EN

ik

NVDS i i Flash [X 3 [yt 4 b ik

ERIA N0, W ASE E Hhdk, NVDSERIA(H HIFlash K B IX 15 .
NVDS (i H [¥JFlash Sector#{

CNYSER

Application i # f¥ICall Stack (¥ K/, BRIA A8 KB.

TF A ATARYE SC PR P 0L, %A .

WRR:

ble_app_example/~ il TR R/, WEHHFX THKeil 5\0bjects\bl
e app_example.htmFHEHZSH K Maximum Stack Usage.
ApplicationfJT 7 ffJHeap A/, BRIA A0 KB.

FF R ATARYE S BRAE P00, AR AR .

I A A RS RS, BRIA{E 0x5405.

PP A7Aif 2 (B RO AR SR L«

WAR:

Z Mk 7 7E Flash ik 76 FE Y

TPz A7 S AR g H ik .

WiAR:

1Z bt 75 5 APP_CODE_LOAD_ADDR{R##F—3, Application>fiXIPik iz
17

BB RGN B R .

0: 64 MHz

1: 32 MHz

2: 16 MHz (X0)

3: 16 MHz

4: 8 MHz

5: 2 MHz

SR THOR S

1: SPA (3{H-20 dBm ~ 5 dBm TXI)%)

2: HPA (3£¥§-10 dBm ~ 15 dBm TXI)ZE)

BWE ARG

0: KFIDC-DCHitHE

1: RAISYS_LDOf L

YA F PO ES  FIHPARY, RS0 RAISYS_LDOfEH.
Bluetooth LEfIRAMHEIRAT PHAE R, HHUEVEREI Y1 ~ 500, HAIPPM.
FE AU A A B A OSCIR i/ Bluetooth LEAERARIENI IR .

LT © 2024 IR TR A A IR 22 7]
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{4 FISDKIT % 137k

M

BOOT_LONG_TIME *

BOOT_CHECK_IMAGE

BLE_SUPPORT

CFG_CONTROLLER_ONLY

CFG_BT_BREDR

DTM_TEST_V1_CMD_ENABLE

DTM_TEST_V2_CMD_ENABLE

DTM_TEST_V3_CMD_ENABLE

DTM_TEST_V4_CMD_ENABLE

DTM_TEST_PRIVATE_CMD_ENABLE

CFG_MAX_PRFS

R

Z# . NICFG_LF_ACCURACY_PPMG 4t il % & 4 500 PPM .
0: AMfEH

1: f£H

BB 8 IR T 7 R s AT G 2 BUS B
0: AZER

1: JER1FD

TEXIPRESNT, ¥4 )3 S B X Image #HAT 1256

0: ARHATIRE

1: BT

715 I FFBluetooth LE

0: JCBluetooth LE, {¥3ZFFMCU

1: XHF

T A FF Bluetooth LE % 2% (FHT-4MM EHLEL HCI vart ££%i)
0: 374¥F Bluetooth LE ¥ #3 Fl L 4

1: {374 Bluetooth LE #5423

15 S HFLEBE A i Bluetooth Classic Link Key .

0: ASCHF

1: XHF

18 /2% FDTMI v 6 4

0: ZEHIDTMI v 4

1: fEAEDTMIIRvL i 4

i B /2% FIDTMI V2 /i 4

0: Z&fDTMIlRv2 4

1: {fREDTMIKv2 7y 4

i /2% FHDTMII V3 A 4

0: ZEHIDTMI V34

1: fEHEDTMIIRV3 A4

181 g /2% F DTMI ikva iy 4

0: ZEHIDTMIva 4

1: fEREDTMIKvA T4

18 6 /4% FIDTMIRFA A fir £

0: ZEFDTMIlAFAA A &

1: fFEREDTMIMFA A dr 4

SRR B K GATT Profile/Service % .

TR TR bR oK, W E . AR, 5 FRIRAMZS FHIEK .

LT © 2024 IR TR A A IR 22 7]
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&= ik
HUETEME: 1~ 64
CFG_MAX_BOND_DEVS XEFERRG E AR, BIMA N4,

SCRFIBROCEREL, K ME 10,

TR # FTARE S2bR R R, W Ei%{H. [Ei#K, Bluetooth LE Stack Heap i H
FRIRAM 7 [H] f K o

Bluetooth LE Stack Heap H A& K /N LR PYAN% (L

Fflash_scatter_config.h) & X:

CFG_MAX_CONNECTIONS
o ENV_HEAP_SIZE

o ATT_DB_HEAP_SIZE
o KE_MSG_HEAP_SIZE
> NON_RET_HEAP_SIZE

BiAR:

TFREA B LRI .

S FFRI B KBluetooth LE Legacy/Extended Advertising %1 .

BUEYEH: 0~5

EE:

Bluetooth LE | #% (Legacy/Extended/Periodic Advertisings) &3S 5

X FEHIECK Bluetooth LE $13# 4K

WAEYEHE: 0~1

T SHFF — R L LA NI .
CFG_MUL_LINK_WITH_SAME_DEV 0: R

1: 3

753 Frcec 3.0 Bluetooth LE OOBZZ4: it %

CFG_MAX_ADVS

CFG_MAX_SCAN

CFG_CCC_SC_OOB_PAIR_SUPPORT 0: A%

1: XFF

5 FEMaster A .
CFG_MASTER_SUPPORT 0: A3FE

1: XHF

F /L FFSlave i .
CFG_SLAVE_SUPPORT 0: A

1: FF

T SCRFIG 7 23 Lo 46 (1 B /N IRV A5 ms
CFG_SUPPER_ADV_SUPPORT 0: ASCHE, ZBEHHE 920 ms

1: XHF

CFG_LEGACY_PAIR_SUPPORT =05 FrLegacy it T o

LT © 2024 IR TR A A IR 22 7] 24
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{4 FISDKIT % 137k

M

CFG_SC_PAIR_SUPPORT

CFG_COC_SUPPORT

CFG_GATTS_SUPPORT

CFG_GATTC_SUPPORT

CFG_CONN_AOA_AOD_SUPPORT

CFG_CONNLESS_AOA_AOD_SUPPORT

CFG_MESH_SUPPORT

SECURITY_CFG_VAL

WDT_RUN_ENABLE

iR

0: ACHF

1: 3CFF

15 Y FiSecurelit X .
0: AXHF

1: XFF

R SCRF I FERGEIE (COO) -

0: A3CHE

1: 3

S5 SCFFGATT Server.
0: ASHF

1: XFF

S5 SCFFGATT Client.
0: A3HF

1: 3CHF

Fe S FF R T B AoA/A0D.
0: ASHF (BRI
1: 3

WiER:

2% ] € B E N0
FE T R A0A/AOD
0: A3HF

1: 3CFF

WiRR:

2 E T B N0
ST X FEMesh I RE .
0: ACHF

1: XFF

ZERE

0: JaHl—45ik
1. Ja g5k

B WDTIhfE
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U0 352 RR:

*: R ZE AT T I U6 BUILD_IN_APP_INFOZERIMAR, Z 45 /AR & AE [E 14 fox200 bk Ak, FFfi
Fcustom_config.h & ) ZZHEATHIUE . RSGLA 5N, Bootloaderf 72> MiZ b Sz B [E 4 I B 15 5, 1E NS
e

e ffAWizardlit B 2%

custom_config.h U4 FIVERE 74 Keil i) ConfigurationWizard Annotations iy . Rk, FF R F & w] LA
TEKeil T “Configuration Wizard” T.E., Bt E custom config.h ¥ % .

LR

WA R A WizardiH T S8 E, DUB G IUARE S HUE .

_] custom_config.h v X
Expand Al | Collapse Al | Help [ Show Grd

Option Value

o conigurtion | -
Chip version 1
Enable system fault trace module  EMABLE
Enable app driver module EMABLE
Eanble APP log module EMABLE
Eanble APP log store module DISAELE
Enable Platform Initialize EMABLE
Enable PMU Calibration EMABLE
The Mumber of sectors for NVDS 1
Call Stack Size 0x0000 2000
Call Heap Size 00000 0000
5K_borad select QFN32

= Beotinfo configuration
Chip version 0x0000 5332
Code load address Flash address i
Code run address Flash address
System clock B4MHZ
System power mode pCDC MODE
External clock accuracy used in th.., 500
Enable internal osc as low power ... Default: Disable internal osc as low power clock j

Basic configuration

m}\ Configuration Wizard ,-[

4-5 Configuration Wizard for custom_config.h

4322 B EFESTRE

fEKeil TREH, Scatter C.sct) SCAFHIRHEH AR 3 H] B A7k X 38 GR5405 SDKFEMHE | —>Scatters< il 3C 1
(SDK_Folder\platform\soc\linker\keil\flash scatter common.sct) , AJ#EBhHFRHEPIHET
MATAE AT RECE . 54, flash_scatter_common.sctfifi 1) % i€ X {Eflash_scatter_config.h™ .
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o

L35 8R:

fEKeilt',  attribute ((section("name"))) A FHT¥ >R E AR & E AERTE N A B
i, o “name” HIFFR#E HE . Scatter(.sct) AT H T8 B & L BOE XAERFE ML E . B, N
Rz (B BlE© XAELFRN “ bss.app” HKINAAETF, MA[KE “attribute” Jy “attribute
((section(".bss.app ")))” -

TERE AT Z M DL 20 BRIC B A 25 A R -

1. shdikeil TEAHHE “Options for Target” %41 & , $THF “Options for Target ‘GRxx_Soc’ 7 X i
HE, PRk “Linker” HRZETL.

2. fE “Linker” TUHI" “Scatter File” %, %4l “...” , WIHEFESDK Folder\platform\soc
\linker\keil FMiflash_scatter_common.sct 3. FTKFEH LW ot Scatter LA Csct) AR E S

(.h) # Ul % ble_app_example LFEHIXT N H 3%, P30 ViR P At

U EER:

*  flash_scatter_common.sct P [{j#! armcc -E - IiEAJIBE T flash_scatter_common.sctiHfi [ S SCAF 1) B

Fo HZMARER, WS Linker Error,

*  TEGR5405 SDKf¥]Scatter XL ff:flash_scatter common.sct™, W] F|Fcustom_config.hi] % i€
S EM_BUFF_ENABLEF 5& SRAM A i X 452 75 75 EL it & H T Bluetooth LEFIEM. R #H HARME LIER& A
4 Bluetooth LEMNVS5, XFEM_BUFF_ENABLEZH/T5E o

3. gy “Edit.” %L ITIFsctICF, ARJEARYE SERR 7 S A A AT R, BT AR

I Options for Target 'GRxx_Sac' X

Device ] Target ] Output ] Listing] User ] C/C++ ] hsm Linker l]]ebug ] Utilities]

I~ Use Memory Layout from Target Dialog */0 Base:
[ Make RW Sections Position Independent R/O Base: |(x00000000
™ Make RO Sections Position Independent R/W Base |0<00060000

I” Dont Search Standard Libraries
I¥ Report might fail' Conditions as Emors

disable Wamings: |

Scat'_:_t“eer AU platformtsocinkertkeil \flash_scatter_common sct j B Edit...

Msc |
controls

Linker |-cpu Cortex-M4fpsp “o A
control  [ibrary_type=microlib —strict —scatter "%\ platform®socinkerkeil'\flash_scatter_common sct”
string A

0K | | Cancel | | Defaults

4-6 fit & Scatter File

4. g “ok” HEHl, fRAFIE.

LT © 2024 IR TR A A IR 22 7]

27



G@D]X {5 F SDKTT & 1813

4.3.3 NINF PR
TR F AT AR SE bR N 753K, /&2 ble_app_example S AH N ARES

4.3.3.1 180 E R
PLR 4L I main. ¢ SO S 25 :

/**Q@brief Stack global variables for Bluetooth protocol stack. wy
STACK HEAP INIT (heaps table);

int main (void)

{

// Initialize user peripherals.

app_periph init();

// Initialize ble stack.
ble stack init (ble evt handler, &heaps table);

// loop
while (1)
{
app_log flush();

pwr mgmt schedule () ;

*  STACK HEAP INIT (heaps table) & X | 7144, ftBluetooth LEWMIARAE JyHeap
Mo FFREATIESILE X, 75 0Bluetooth LEWMYAR I BETLILIE #1817 . Heap K/N54.3.2.1 it
H custom_config.ht f]Bluetooth LENV 55 45 5% .

* app periph init () HT#IMGEAINE. £ KRB, %K% ISYS_SET_BD_ADDRW A 1%
B [FJPublic Address, pwr_mgmt_mode_set()F 7] & B 1£ H ) Dh#EE H I MCU ) TAERIX (SLEEP/
IDLE/ACTIVE) . app_periph_init() R EUSZ BT T user_periph_setup.c 3O, HonBIACES U R frs

/**@brief Bluetooth device address. */
static const uint8 t s bd addr[SYS BD ADDR LEN] = {0Ox11, O0x11, Ox11, O0x11,0x11, Ox11l};

void app periph init (void)
{
SYS SET BD ADDR (s bd addr) ;
board init();
pwr mgmt mode set (PMR MGMT SLEEP MODE) ;

e ffwhile (1) { }"¥INApplicationffiMain LoopfCHd, ELinALFEANERAAN . HEHGUI.

* H4TITApp LoghEid, NIR7EMain LoopH i Happ log flush (), LARIERGHEASleepREZ
A, Se%H i Log. 5T -App Loghibfii i, Z%4.6.3 fithiHikLog.
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*  JiMpwr mgmt shcedule () SCHLHBIIIFEEE, VIR ARFRIFE.

4.3.3.2 SL¥1Bluetooth LEM! %%1Z 45

Applicationf]Bluetooth LEMV 551 %5 HHGR5405 SDKH 5 X )45 T-Bluetooth LE Eventsi#E{TEKZ). [AlIk
, Application i ZSZHLAH N FYEvent Handler, LAFkH{Bluetooth LE Stackfiz 4745 BN SR HidE A . T Event
Handler 2 7EBluetooth LE SDK IRQfFJH T F R 3¢ CInterrupt Context) " iE A 1), KT & & A GELEHandler
PAT LB 3, IanPHZE R B A . IRIEM . BN, FIREFHZEREA RG0is1T, FEBluetooth LE
Stack 5 SDK Bluetooth LERLERIGI24% it IE I FPig 4T .

Bluetooth LE Events%fCommon. GAP Management . GAP Connection Control. Security Manager
» L2CAP. GATT Common. GATT ServerflIGATT Client4)%.

(10 35488

GR5405 SDK3Z ##Bluetooth LE EventsA[ fESDK_Folder\components\sdk\ble event.h$H&FH.

TR & FHREF= I RE T K, ST 7 ¥ Bluetooth LE Event Handler. I, 7% fhAS S FiSecurity
Manager, WA JCFESZHLGS R Event; 75 77 dh A L RFGATT Server fii AN SZ FFGATT Client, U 7] G 75 SEELGATT
ClientX} N ffjEvent. I H., XFT4E25EventfEvent Handerth 7 AE 5 4 B9, AN 75 S2HL 5 BT 4 2 Event
HanderBE[I 7] .

RR:
KT Bluetooth LE APIFIEvent APIKIff FH /775, 162 %SDK Folder\documentation\GR5405 API Refere
ncell X SDK Folder\projects\bleH []Bluetooth LEZ~{FIJEHAHY

4.3.3.3 BLE_Stack_IRQ. BLE_SDK_IRQ5 Applicationf41EE #/1#l

Bluetooth LE Stack /& (K IHFEWE F P SEBIAZ 0, 7] B {EBluetooth 5.3 Corefififf (Z3#2.2 HifF4¢
) o Ak, BLE_Stack_IRQEAEANRGH RIS (sveall ROEA mmthedl) , LUfRiEBluetooth LE

N— S

Stack™ 1% 1% Bluetooth Core Spectl 5& HI} iz 4T .

Bluetooth LE Stack IR e 48 2 fi K A e B AR YT BLE_SDK_IRQH W1 7E1% A Wi Ab 28 ek 4, ml i i i
FH Application 32 ¥ i/ Bluetooth LE Event Handler, ¥$Bluetooth LE Stack bR 2578 55 i@ %1 DA K2 AH 5 Ak 55 HiE &
15 % Application. 7EIX%EEvent Handler ', Sk GuigfERERS (10155, 10 R FERT MV 55 % 7 2 Main Loop Bk
PRAFET A, FFRKE A SDK Folder\components\libraries\app queuefilt (B{HE X
fJApplication Framework) MBluetooth LE Event Handler[i]Main Loop/% i S 1f .

JEAUITA © 2024 FIINTHEBEMBAR A IR A 7 29



G@DIX {5 F SDKTT & 1813

app_queue_init

Application Application Application
@ SBIBEE Callback Queue Main Loop
I I b

BLE_Stack_IRQ |

BLE_SDK_IRQ

BLE Event Handler

1 app_queue_pop
«—

JUaA3 3|pueH

4-7 Non-0S system schedule

4.4 % R EH

THEmFERINE, BELEH X TR ListingsfMobject s CAFIE T 43 525 . bin T hex = [l 44 S

.
< 4-5 H RV EH
AR ik
ble_app_example.bin b N A, A8 GProgrammer [ # 2  FrFlashHHiE 4T .
ble_app_example.hex BN [, AT Keil Bk GProgrammer T .22  Fr Flash 24T o
DRR:

IR FAE P EA, Y RT S FH GProgrammer Nk 25 FFlash iz {7, HAREEAE, 7122 (GProgrammerH

F) .

4.5 T Z.hex3SZ {4 ZEFlash
FERAE RS, AT 4% LR D B [E F R 22 Flash 7 :
1. i B Keil Flashgm 28,
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(1) #UsSDK Folder\build\Keil\GR5xxx 16MB_Flash.FLM¥Xff%#Keil Folder\ARM\F

lashHx.

(2)  AiKeil TEFHE “Options for Target” #%4l & , FTHF “Options for Target  ‘GRxx_Soc’ ” Xf
TEHE, EFE “Debug” #pZET1; sy “Use: J-LINK/J-TRACE Cortex” £ fl[] “Settings” %4

M Options for Target 'GRxx_Sac'
Device I Target I Output I Listingl User I C/C++

" Use Simulator ~ with restrictions  Settings

X
I Asm I Linker Utilitiesl
| || tse: [HNK/STRACE Cotex+] _Settings ||

[~ Limit Speed to Real-Time

V¥ Load Application at Startup ¥ Run to main()

Initialization File:

I J Edit...l I..\..\..\..\..\build\keil\smm.ini

™ Load Application at Startup
Initialization File:

¥ Furn to main(]

Restore Debug Session Settings Restore Debug Session Settings
[V Breakpoints V¥ Toolbox [V Breakpoints ¥ Toolbox
¥ Watch Windows & Perfformance Analyzer ¥ Watch Windows
V¥ Memary Display V¥ System Viewer V¥ Memary Display ¥ System Viewer
CPU DLL: Parameter: Driver DLL: Parameter:

ISP.HMCME‘..DLL | MPU
Dialog DLL: Parameter:

IS:\HMCME‘..DLL | MPU
Dialog DLL: Parameter:

IDCM.DLL I-pCM-i

[~ Wam if outdated Executable is loaded

ITCM.DLL I-pCI'u'I-i

[~ Wam if outdated Executable is loaded

Manage Component Viewer Description Files ... |

0K |

Cancel | Defaults |

Help |

[& 4-8 DebughrZ T

(3) TE4TFFIA) “Cortex JLink/JTrace Target Driver Setup” & 11+, & “Flash
Download” Jji. 7E “Download Function” X%, F & #& LAk EErase /720, iEF 2

5 “Program” . “Verify” . “Resetand Run” . KeilZRIABCE 1T :

Cortex JLink/JTrace Target Driver Setup *

Debug | Trace Flash Download |
— Download Function RAM for Algorithm

LORD ¢~ FErase Ful Chip ¥ Program

Fq © FeseSectos [V Very Start: [(x20000000  Size: [BFFFO

" DonotErase |V Reset and Run

—P ing Algorithm

Description | Device Size | Device Type | Address Range I

Start: | Size:
Add | Remove I
oK Cancel Apply

[&] 4-9 i%£#% “Download Function”
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(4)  ridy “Add” #%Hl, 7£ “Programming Algorithm” HH¥RHIISDK_Folder\build\keil\GR5xxx
_16MB_Flash.FLM.

L 54 BR:
FTAEF P 208 kAR MEIT R, & FFGRoxx £ §lJBluetooth LEAS F R #B09%, 3418 FHGR5xxx_16MB_Flash.FLM
.,

Cortex JLink/JTrace Target Driver Setup s

Debug I Trace Flash Download

Download Function RAM for Algorithm

LOAD " Erase Full Chip ¥ Program
‘; (+ Erase Sectors [ Verify Start: |D’{ZDDDDDDD Size: |D"SDDD
" Do notErase [ Reset and Run

Programming Algarithm

Description Device Size Device Type Address Range
GRIx00x_16MB_Flash 16M Ext. Flash SPI 00200000H - 401FFFFFH
Start: | Size:
Add

[ == | m%‘|

[&] 4-10 FRAMGR5xxx_ 16MB_Flash.FLM#RIZE 3%

(5) FCE “RAM for Algorithm” , VL& SUINE AN PAT G FE L P bt 2= 0] . “Start” B % WGR5405
RAMFHE 4G HAE “0x20000000” ,  “Size” {EH N “0x8000” .

RAM for Algorithm

Start: | 0x20000000 Size: |uxanuu

4-11 “RAM for Algorithm” % &

(6) iy “oK” , fRIFEE.

2. R

fid & 52 bl ,  Aidikeil THAZAFH “Download” #4411 ¥ F¥ible_app_example.axf XA 220
JrFlashib o IR N KD, Keil¥) “Build Output” & FRRF /R a1 R 45 2R
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Build Output x|

Load " X X 4 projects\\ble\\ble peripheral\\ble app template\\Keil 5\\Cbjects\\ble_app example.axf"
Set JLink Project File to " ) 4 b 4 4 projects\ble\ble peripheral\ble app_template\Keil 5\JLinkSettings.ini™
* JLink Info: Device "CORTEX-M4" selected.

JLink info:

DLL: V5.12e, compiled Apr 29 2016 15:03:58

Firmware: J-Link OB-SAM3U12E8 V3 compiled Apr 16 2020 17:20:41
Hardware: V3.00

S/N : 483113122

* JLink Info: Found SWD-DP with ID 0x2BA01477
* JLink Info: Found Cortex-M4 rOpl, Little endian.

* JLink Info: FPUnit: 15 code (BP) slots and 2 literal slots

* JLink Info: CoreSight components:

* JLink Info: ROMTbl 0 @ EGOFFO00

* JLink Info: ROMTbl 0 [0]: FFFOF000, CID: Bl0OSE0OD, PID: 000BBOOC SCS
* JLink Info: ROMTbl 0 [1]: FFF02000, CID: Bl0OSE00D, PID: 003BBOOZ DWT
* JLink Info: ROMTbl 0 [2]: FFF03000, CID: 00000000, PID: 00000000 2?22
* JLink Info: ROMTbl 0 [3]: FFF01000, CID: Bl0OSE0OD, PID: 003BBOO1 ITM
* JLink Info: ROMTbl 0 [4]: FFF41000, CID: B105900D, PID: 000BBSAl TPIU
ROMTableAddr = OxEOOFF000

Target info:
Device: RRMCM4 FP

VTarget = 3.300V

State of Pins:

TCK: 0, TDI: 1, TDO: 1, TMS: 0, TRES: 1, TRST: 1
Hardware-Breakpoints: 15

Software-Breakpoints: 8192

Watchpoints: 4

JTAG speed: 2667 kHz

Erase Done.
Programming Done.

Verify CK.

Application running ...

Flash Load finished at 17:04:35

4-12 TEER

(05 RR:

THLESD, HRAMmIER “No Cortex-M SW Device Found” , NIZR~0H S AT g4t FREOIRES  (BIJT /S BEAR
BRI TRRIEFIZIT) » THEEHE T hex X ERIFlash . JT R # % 253% T GR5405 SKHR 1] “RESET” %, [A]
Ma1Rb e fs, 5 “Download” #%4H ¥, HHT N #HCH:

4.6 i

Keil Rt T U548, SCHFICRDELR MR . 1% RS 7 F5 1 B 6 /MBI SR 22 BRI 2. TR 38 7T A
i 2 Fh o7 R B A A 4
4.6.1 Ft B i 28

JASNRZ AT, TR E RS . Aidikell THEAFH) “Options for Target” %4l &, #TFF “Options for
Target ‘GRxx_Soc’ ” XJiHHE, EF “Debug” WrZEUl. & L ZEMIENEAEG HRRECE, A5 M AR {75 28 1k
=

Bluetooth LE Examples T 28 FIREF7E 2R IG0, AHOCH AR B BC B 4l R -
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iﬂ::::'s": Target 'GRxx_Soc

Tevice ] Target ] Output ] Listing] User

" Use Simulator
™ Limit Speed to

Iv¥ Load Application at Startup

Initialization File:

with restrietions

Real-Time

¥ Run to main()

|csces | hsm | Linker |Debuz |Utilities|

Setings | If-‘ Use: [J-LINK / J-TRACE Cortex

ﬂ Settings |I

™ Load Application at Startup v
Initialization File:

Restore Debug Session Settings
W Toolbox

[v¥ Breakpoints

| [¥ Watch Windows & Perfformance Analyzer
[v System Viewer

¥ Memory Display

A build eeilsram ini

Restore Debug Session Settings
[v¥ Breakpoints ¥ Toolbox
W Watch Windows
Iv¥ Memory Display

Iv¥ System Viewer ‘

CPU DLL: Parameter: Driver DLL: Parameter:
| |SARMCM1DLL|-MPU |SARMCM1DLL|-MPU

Dialog DLL: Parameter: Dialog DLL: Parameter:
| |DCMDLL |pCM4 FCMDLL |pCM4

™ Wam if outdated Executable is loaded

Manage Component Viewer Description Files ... ]

™ Wam ff outdated Executable is loaded

0K | Cancel I Defaults |

4-13 L E i 25

Help

BRIME H fInitialization File (sram.ini) £ T°SDK_Folder\build\keil H3k. JFA& Al LLEHA8 1%L
i, AT DCR iz R B E TR H S ] .

WIUEA S sram.inib AL & — AR 4,
f1 “Edit...” $%4H, AT FFsram.iniSCAF.

sram.inift)ARBS 7R U :

/**

IR PAT IR A . A

7 “Initialization File” #4511

AR A AR AR A A A A A A A A A A A A A A A A AR A AR A AR AR A AR A AR AR A AR A A A AR AR A A A A A A A Ak A kA Ak A Xk k%

*GR55xx object loading script through debugger interface

(e.g.Jlink,

etc) .

*The goal of this script is to load the Keils's object file to the GR55xx RAM

*assuring that the GR55xx has been previously cleaned up.

Ak Ak kA hhkhhhkhhhkhhk Ak kA hhkrhkhkhhhkhk kA hhkhhhkrhhkhhhkh kA hkhkrkhhkrhkhkrhkhkhkhkrhkkrhkxkhkxxk*x

*/

//Debugger reset (check Keil debugger settings)

//Preselected reset type

(found in Options->Debug->Settings)is Normal (0) ;

//-Normal :Reset core & peripherals via SYSRESETREQ & VECTRESET bit

RESET

//Load current object file
LOAD %L

//Load stack pointer
SP = RDWORD (0x00000000)

//Load program counter
$ = RDWORD (0x00000004)

//Write 0 to vector table register,

remap vector

LT © 2024 IR TR A A IR 22 7]

34



G @D] X {5 F SDKTT & 1813

__WDWORD (0xE000EDO8, 0x00000000)

//_WDWORD(OXEOOOEISO, OXFFFFFFFF)

//Write run address to 0xA000C578 register,For the debug mode;

//boot code will check the value of O0xA000C578 firstly,if the wvalue of 0xA000C578 is

valid,gr551x will jump to run

//_WDWORD (0xA000C578, 0x00810000)

(035 RR:

K

1.

3.

4,

eil SCRAZIR LU U $AT IF 5 i B R X a8 a2

24 “Options for Target ‘GRxx_Soc’ > Debug > Load Application at Startup” #f#HE, VHilgs 1oL
A “Options for Target ‘GRxx_Soc’ > Output > Name of Executable” H )3 44 .

AT “Options for Target ‘GRxx_Soc’ > Debug > Initialization File” FT#g & CAFH A4 o

24 “Options for Target ‘GRxx_Soc’ > Debug > Restore Debug Session Settings” & HiETigE+, RKEAM
M. HJBreakpoints. Watch Windows. Memory Display% .

24 “Options for Target ‘GRxx_Soc’ > Debug > Run to main()” #i%&HE#E 4 g, maini KL
Tinitialization File, JiA# BT 46 H ZPATCPUTE S, B RIEEImain()4 21 F K.

4.6.2 BThfEi

SRR E S, AdiKeil TEARF ] “Start/Stop Debug Session” ##%Z4 @, BT A58

LY 358 RA:

S

“Connect” FBEN “Normal” , “Reset Options” &% & AN “Core” (AN NEFIR) , MRIEIEE] “Debug
ession” Z 5, miifiKeil LEAEHH) “Reset” 44, FEFIIGEIERIZIT.
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Cortex JLink/ITrace Target Driver Setup

Debug lTrace ] Flash Dcwnload]
J-Link / J-Trace Adapter
s\ [evoozsera o]
Device: J-Link/J-Trace
Hw: | vioo g ve4s
[1-Link OB-STM32F072-Corte

Port: Max
5 B

|sw |5 MHz
Auto Cl\-c|

FW

SW Device
IDCODE Device Name
SWDI| @ 0x2BAD1477  ARM CoreSight SW-DP

Connect 8 Reset Options

Cache Options Download Options

Connect:

j Reset: ‘ Core

I~ Verify Code Download
[~ Download to Flash

j [v Cache Code
[ Cache Memory

W Reset after Connect

Interface TCR/IP Misc

Network Settings

« USBE " TCP/IP g
IP-Addres: Part (Auto: Autodetect JLink Info
Scan ‘ 127.0 .0 . 1 | 0
| Jlink Cmd ‘
State: ready
[oe 1= | oo |

4-14 “Connect & Reset Options” HL &

4.6.3 HiH it Log

GR5405 SDKFEHLAPP LOGHEH,  RJ S REfil i 11 % H Applicationifl i Log, FH3ZFIT A H 5 X 77
7: UART. J-Link RTTEXARM ITM (Instrumentation Trace Macrocell) .

Frf# FHAPP Loghiibl, 75 7Ecustom_config.h 4T FF % APP_LOG_ENABLE, JF:HR4F Fir 75 4 77 X AC &
% APP_LOG_PORT.

4.6.3.1 IRERFNIEL

SERIRE G, HFREETAINEVIG B, Happ log init () 58K APP LOGHEEERIHIMATL, 3%
fic & LogZ %, v M Loghn H 2 T FIFlush % 1 o

APP LOGHE R 3 7 # F bR HECHE B Bprint £ () AIAPP LOG APIFa H! i Log. #f8 FIAPP LOG API, i@t
W ELogZl. #A I AESH A Loghnth: HEHprinte (), WK LogZ #ik B INULL.

MR TT R s B R 720, AR Wi da b 4 (AW 2% SDK Folder\platform\boa
rds\board SK.c) , FF{FEMAHN I Loghi 2 LI MIFlush#2 11, T 275 K £ bsp_log_init().

PLUARTH 7 o1, bsp_log_init()SZELAN R -

void bsp log init (void)
{
#if APP LOG ENABLE
#if (APP_LOG_PORT == 0)

bsp uart init();
#elif (APP_LOG PORT == 1)

SEGGER RTT ConfigUpBuffer (0, NULL, NULL,

0, SEGGER RTT MODE NO BLOCK TRIM);
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#endif

#if (APP_LOG_PORT <= 2)
app_log init t log init;

log init.filter.level = APP LOG LVL DEBUG;
log init.fmt set[APP LOG LVL ERROR] = APP LOG_FMT ALL & (NAPPiLOGiFMTiTAG);
log init.fmt set[APP LOG LVL WARNING] = APP LOG FMT FUNC;
log init.fmt set[APP LOG LVL INFO] = APP LOG FMT NULL;
log init.fmt set[APP LOG LVL DEBUG] = APP LOG_FMT NULL;
#if (APP_LOG PORT == 0)

app log init(&log init, bsp uart send, bsp uart flush);
app_log assert flush init (bsp uart assert flush);

#elif (APP LOG PORT == 1)

app _log init(&log init, bsp segger rtt send, NULL);
#elif (APP_LOG PORT == 2)

app log init(&log init, bsp itm send, NULL);
#endif

#endif

app_assert init();
#endif
}

L1 58 BR:
app_log_init()#% L AN S E U LogW ia L Z 0. Loghn 2 U AIFlush#% 1. Hirb, Flush$% Ha] DLIE A
i

2 FHUART#i il Log e, S Loghar H 482 U AT Flush$22 1143 51 Aybsp_uart_send()flbsp_uart_flush().

*  bsp_uart_send()SZI [ app_uart[F]2F (app_uart_transmit_synctz 1) 7= H 0, FF & FE A LA
B Napp_uart#2 (app_uart_transmit_asynci 1) 7 M4 O . iR SLPrTER, EHEEE
1) Log#i th 77 Ko

*  bsp_uart_flush()Auart_flush#2 [, F T A Wrsi =R 5 A7 H 247 B Log 504 -

(1 {5 BR:
HRFH T EE LA O R

481 FHJ-Link RTTEKARM ITME] Hi U7 iLoghT, T SEI I Login Hi 2 11143 7l bsp_segger_rtt_send() #/l
bsp_itm_send(). FEXPIFEEAT, #AHLIFlushiz .

4.6.3.2 ERAAE
APP LOGHRERWIGE AL SE G » T &34 T DA H LA DU/ AP H 1 1 Log:

«  APP_LOG_ERROR()
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{4 FISDKIT % 137k

«  APP_LOG_WARNING()
< APP_LOG_INFO()

«  APP_LOG_DEBUG()

AR SR A b i A5, AT F app_log_flush () B8 B0k 247 h 4 R ik Logfar e, AT DRATE S Fr A B R

GURENRZ AT, A8 i Log.

e PEAE FJ-Link RTT 7 2050 H Loghtt,  HEFE{ESEGGER_RTT.cFR i M &4

SEGGER_RTT.c
238 | *

239 | * Static data

248 | *

242 -#/

243 //

244 // RTT Control Block and allocate buffers for channel @

245 //

246 _ attribute_ ((section (".ARM. at 0x20005008"))) SEGGER_RTT_CB _SEGGER_RTT;

247 //SEGGER_RTT_PUT_CB_SECTION(SEGGER RTT_CB_ALIGN(SEGGER_RTT_CB _SEGGER_RTT));

4-15 BIJZRTT Control BlockF & T #111k0x200050004%

A 6F)-Link RTT Viewer#H/THCE , WA 2% K 4-16HH S HICE .

m J-Link RTT Viewer V6.88a | Configuration ?

Connection to J-Link

(®) UsB
) TCRIP

[ serial Mo

O Existing Session

Specify Target Device

| coRTEX-M4

Script file (optional)

Target Interface & Speed

SWD

RTT Control Block

(®) Address

() Search Range

Enter the address of the RTT Control block.
Example: 020000000

| 0x20005000]

Cancel

4-16 BL B J-Link RTT Viewer

Hrp “RTT Control Block” F3idi Al i@ “Address” 772048 5E, i AE 7] 15 B N Yw 1% TREAE ). map i 5t
CAEFR ¢ SEGGER_RTT” ZEMIRRHuIE, W FEFTR. 4% 4-15#E7E 757 LB EERTT Control Block K5 H & T-Hh
1-0x200050004k, M “Address” MW E A “0x20005000” .

ultra_wfi_or_wfe
sdk_gap_env
_SEGGER_RTT
jlink_opt_info
SystemCoreClock
_ stdout

Bx208837ec Data
Ox2000838ec Data
Ox20085000 Data 12
Bx200806000 Data
0x2000bo0e Data
2x2000bo44 Data

AR OOO

[&] 4-17 3RBYRTT Control Blockithiit

rom_symbol .txt ABSOLUTE
rom_symbol.txt ABSOLUTE
segger_rtt.o(.ARM.__at_ 8x20005080)
rom_symbol . txt ABSOLUTE
system_gr55xx.o(.data)

app_log.of .data)

JEAUITA © 2024 FIINTHEBEMBAR A IR A 7
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4.6.4 {£ FH GRToolboxiFizt,

GR5405 SDK#EEGRToolbox App (Androidfix) , ] F-TGR5405 Bluetooth LEN F ik . 1ZApp T EHLHLLLF
Dirg:

« @M MBluetooth LEFHE F1i%E4E, *fCharacteristics/{3E 5 o
o britEProfile)DemofE ~, HIGHeart RateZs.

*  GoodixH E XN

R

GRToolbox % % U ] ML TR RIFRI, B 1375 3

4.7 FFRIARTE, AR

GR5405 SDKIF 7Rl TAEAM AL FrKeil TAZ, BFEME TIARTAE, W] 77 (8 F {8 HIAR T B pRis g %
Bl TR, AERON FHE . 140, ble_app_templatesm Bl ffIIAR T#247 F SDK_Folder\projects\bl

e\ble peripheral\ble app template\IAR. %ii¥ble_app_template.eww T ¥, A flH 3L
{ble_app_template.bin.

projects » ble » ble peripheral » ble app template » AR

Fay

=i E=iel

[ | ble_ app_template.ewd EWD 37

| | ble app_template.ewp EWP 30i

[ ] ble_ app_template.ewt EWT 2i%

| | ble app_template.eww EWW =25

[ | flash_icf_config.c CiEg
GRw0o_make icf.bat Windows #t4HE..
[ | gr5405.ict CF 30i%

[# make app_dependent icf.py Python File

4-18 IARTEHFR
A5 AR 285 FH R K ] 2 () 3 AR 2D R D R

1.  FEIARIDEMISZEF:G, %FF “Project > Options” , FTHFECE & I 7EL MK “Category” #FE ik
i “Debugger” , SRJGTE “Setup” TUIHIHY “Driver” £k $E “J-Link/)-Trace”

2. ¥4SDK Folder/build/iar#ff® FHIFEEZC
14GR5xxx_IAR_16M.board GR5xxx_IAR_16M.flashA }.GR5xxx_IAR_flashloader_16M.out#% N1 &

IAR Install/arm/config/flashloader/Goodix (FH', IAR_Instal AIARE %% H
3K, Goodi AT AT I .

3.  {EIARIDEH, i#EFF “Project > Options > Debugger > Download” , fOverride default .board file % &
NGR5xxx_IAR_16M.board (A (fiT'IAR Install/arm/config/flashloader/Goodix) -

FAUITE © 2024 RYINTIC TR A% (0 A BR A 7] 39
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G@Dix {8 FI SDKH- & ik

4. TEIARIDEH, %P “Project > Options > Debugger > J-Link/)-Trace > Setup” , 7E “Reset” f=Hik

£ “Core” .

5.  7EIAR IDEMFSEHAFE, %&FE “Project > Download > Download Active Application” , 7E# H [ % 15 HE A
My “oK” ¥ZEH, BIRTIRAG R AR E A

6. [ NESERNUE, &I Ak, s TR,

7. ZEIAR IDEFFSEEFET, iEFE “Project > Debug without Downloading” , #E A Hit.

LT © 2024 IR TR A A IR 22 7]
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ARG 5 4RN8E
5 RiE54amE
£ 5-1 RESHEEEE
B ik
API Application Programming Interface, N FFEF gfe$E:
ATT Attribute Protocol, JEEHMNE
Bluetooth LE Bluetooth Low Energy, KIIEWF
DFU Device Firmware Update, £ &l 557
DTM Direct Test Mode, L2l i A5
DUT Device Under Test, il %%
GAP Generic Access Profile, 3 i [M#13E
GATT Generic Attribute Profile, i & HIVE
GFSK Gaussian Frequency Shift Keying, =& 4ifs 4%
HAL Hardware Abstract Layer, f#{-4% )2
HCl Host Controller Interface, =EAL-#&H 7% H
HPA High Power Amplifier, =IIZBOKEE
L2CAP Logical Link Control and Adaptation Protocol, & %5 5% B4 5 & B frid
LL Link Layer, FEH)Z
NVDS Non-volatile Data Storage, :IE 5 5045 77 fif
PMU Power Management Unit, FELEEHH T
PHY Physical Layer, #3412
RF Radio Frequency, 54
SCA System Configuration Area, ZRZiHLE X
SDK Software Development Kit, f4H & T H A
SM Security Manager, %45 FHAE
SoC System-on-Chip, R
SPA Small Power Amplifier, /NIZRBUK#
UART Universal Asynchronous Receiver/Transmitter, 75U R AL %
XIP Execute in Place, /i LE#HAT
SR © 2024 VRIITHIC TR B4 A7 B A 7 a1
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